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Featuring:

* Memristor Macros
* Using the Tolerance Dialog Box
 Adding File Links to a Schematic

Memristor Macros




News In Preview

This newsletter's Q and A section describes how to capture images of the schematic and analysis plots
in Micro-Cap for use in documentation. The Easily Overlooked Feature section describes the use of
the Accumulate Plots option to easily compare plots created while editing the circuit in an analysis
mode.

The prstarticle describes new macro models that simulate the memristor which is the fourth elementary
passive element (in addition to the resistor, capacitor, and inductor) that was prst theorized about by
Prof. Leon Chua in 1971 and pnally developed recently by HP Labs.

The second article describes the use of the Tolerance dialog box as a means to quickly add, edit, or
remove Monte Carlo tolerances for any of the applicable components in the schematic.

The third article describes how to add links to ples directly in the schematic. This feature can be very
useful when associating documentation such as application notes, design specipcations, or manufacturer
data sheets to a specipc circuit.
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Book Recommendations

General SPICE

* Computer-Aided Circuit Analysis Using SPICE, Walter Banzhaf, Prentice Hall 1989.

ISBN# 0-13-162579-9

 Macromodeling with SPICE, Connelly and Choi, Prentice Hall 1992. ISBN# 0-13-544941-3

* Inside SPICE-Overcoming the Obstacles of Circuit Simulation, Ron Kielkowski, McGraw-Hill, 1993. ISBN#
0-07-911525-X

* The SPICE Book, Andrei Vladimirescu, John Wiley & Sons, Inc., 1994. ISBN# 0-471-60926-9
MOSFET Modeling

* MOSFET Models for SPICE Simulation, William Liu, Including BSIM3v3 and BSIM4, Wiley-Interscience,
ISBN# 0-471-39697-4

VLSI Design
* Introduction to \VLSI Circuits and Systems, John P. Uyemura, John Wiley & Sons Inc, First Edition,
2002 ISBN# 0-471-12704-3

Micro-Cap - Czech
* Resime Elektronicke Obvody, Dalibor Biolek, BEN, First Edition, 2004. ISBN# 80-7300-125-X

Micro-Cap - German
» Schaltungen erfolgreich simulieren mit Micro-Cap V, Walter Gunther, Franzis', First Edition, 1997. ISBN#
3-7723-4662-6

Micro-Cap - Finnish
* Elektroniikkasimulaattori, Timo Haiko, Werner Soderstrom Osakeyhtio, 2002. ISBN# 951-0-25672-2

Design
* High Performance Audio Power Amplipers, Ben Duncan, Newnes, 1996. ISBN# 0-7506-2629-1

» Microelectronic Circuits, Adel Sedra, Kenneth Smith, Fourth Edition, Oxford, 1998

High Power Electronics
« Power Electronics, Mohan, Undeland, Robbins, Second Edition, 1995. ISBN# 0-471-58408-8

* Modern Power Electronics, Trzynadlowski, 1998. ISBN# 0-471-15303-6

Switched-Mode Power Supply Simulation
» SMPS Simulation with SPICE 3, Steven M. Sandler, McGraw Hill, 1997. ISBN# 0-07-913227-8

* Switch-Mode Power Supplies Spice Simulations and Practical Designs, Christophe Basso, McGraw-Hill 2008.
This book describes many of the SMPS models supplied with Micro-Cap.



Micro-Cap Questions and Answers

Question: | am creating documentation for my circuit, and | would like to use graphic captures of
the schematic and simulations within the documentation. Is there a way to create picture ples within
Micro-Cap so I can easily import these images into my documentation?

Answer: There are two methods for capturing the schematic and analysis plots to a graphic image.
These images can either be copied to the Windows clipboard to paste in another program, or they
can be saved to a ple on the hard drive which can then be imported into another program.

In order to copy an image into the Windows clipboard, the group of commands available in the
Copy to Clipboard section of the Edit menu may be used. These command are as follows:

Copy the Visible Portion of Window in BMP Format: This command copies the visible portion of
the active window to the Windows clipboard in BMP format.

Copy the Select Box Part in BMP Format: This command copies the portion of the schematic that
is enclosed within the select box to the Windows clipboard in BMP format. Only the portion of the
select box that is visible in the active window will be copied.

Copy the Entire Window in WMF Format: This command copies all contents of the active window
to the Windows clipboard in Windows Metaple format.

Copy the Entire Window in EMF Format: This command copies all contents of the active window
to the Windows clipboard in Enhanced Metaple format.

The second possibility is to create a picture ple through the Copy the Entire Window to a Picture
File command available in the Edit menu. This command creates a picture ple in one of many avail-
able formats from the front window. The ple can then be imported into Micro-Cap or other Win-
dows applications. The picture formats that are available are: BMP, JPEG, GIF, EMF, WMF, TIFF,
and PNG.



Easily Overlooked Features

This section is designed to highlight one or two features per issue that may be overlooked among all
the capabilities of Micro-Cap.

Accumulate Plots option

The Accumulate Plots option is an option that is available within the Transient, AC, DC, and Distor-
tion Analysis Limits dialog boxes. When enabled, this option accumulates waveforms or curves that
result from editing the circuit while still in the analysis mode. It provides a simple method to com-
pare the results of a circuit before and after editing. There is no limit to the number of analysis runs
that can be accumulated. Exiting the analysis mode clears all of the data.

The sample circuit PRLC.CIR is used to demonstrate how this option works. Once the circuit is
loaded, the Transient Analysis command is selected under the Analysis menu. In the Transient Anal-
ysis Limits dialog box, the Accumulate Plots option is enabled. The analysis is then run. While still
in the analysis, the circuit window is activated, and the inductor value is changed to 2uH. The circuit
is simulated again. Both simulations are now available in the plot window for easy comparison as
shown in the pgure below.
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Fig. 1 - Accumulate Plots enabled analysis

The Dynamic Auto Run option in the Preferences - Options - Analysis section forces a new simula-
tion run every time an edit is made in the circuit while in an analysis. If more than one edit needs
to be made prior to a simulation, this option needs to be disabled. In this case, once all the edits are
made, the simulation would need to be manually started by the user by hitting F2 or using the Run
command.

The Clear Accumulated Plots under the Scope menu will clear all of the prior runs the next time a
simulation is started. The toolbar icon for this command is the following:

|



Memristor Macros

The memristor device is the fourth elementary passive element (in addition to the resistor, capaci-
tor, and inductor) that was prst theorized about by Prof. Leon Chua in 1971 and pnally developed
recently by HP Labs. The resistance of the memristor will change depending on the yow of charge
for the device. If the charge yows in one direction, the resistance of the device increases. If the
charge yows in the other direction, the resistance of the device decreases. The key to the memris-
tor is that when the yow of charge stops, the device remembers the last resistance it was at, so that
when the yow of charge resumes, the device also resumes operation at the previous resistance. The
memristor has great potential for low power, high density memory applications.

Prof. Dalibor Biolek, who helped develop a SPICE model for the memristor (Reference 1), has gen-
erously supplied Spectrum Software with a couple of memristor macros along with four test circuits
which are in Micro-Cap 9 format. The ples are available in the Summer 2009 section of our News-
letter page on the website.

The prst memristor macro (Memristor_J.Mac) uses the Joglekar window function which is the con-
ventional model for simulating the nonlinear dopant drift of a memristor. Driving this memristor
macro with a 1.2V, 1Hz sinusoidal voltage produces the transient simulation shown below.

50.00

40,0000

30.000u

20,0004

10.000u

oo 0.000m 80.000m 160.000m
VW .CHARGE
WRALFLU) ()

200,00

100.000u

0.000u

1000000

-200.00

200.000u

100,000y

0.000y

100,000y

200 000y

Fig. 2 - Driving the memristor with a sinusoidal voltage

The top plot shows the relation between the charge and the yux of the memristor which dem-
onstrates the one-to-one correspondence between the two as expected in memristor theory. The
second plot shows the hysteresis loops within the I-V curves of the memristor. Increasing the fre-
quency of the driving sinusoidal voltage will gradually suppress the hysteresis curves. The third plot
displays the voltage and current waveforms of the memristor in the time domain. The bottom plot
shows the ratio of the actual width of the doped area to the width of the entire memristor thin plm.
In this simulation, the ratio does not approach the boundary limits where the dominant nonlinear
effects occur.



Lowering the Roff/Ron ratio of the memristor and increasing the sinusoidal voltage to 2V produces
a simulation that displays the hard switching case. The transient simulation for this conpguration is
shown below. This simulation was run a few times with the State Variables option set to Leave in
order to reach the steady state operation.
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Fig. 3 - Hard switching memristor simulation

The same plots from the previous simulation are plotted again. As can be seen in the bottom plot,
the hard switching occurs when the ratio of the width of the doped region to the width of the
memristor is switched between the low and high boundary limits. The corresponding nonlinear ef-
fects of the hard switching can be seen in the current plots of the memristor.

The second memristor macro (Memristor_B.Mac) uses the Biolek window function for simulating
the nonlinear dopant drift. The Joglekar window function used in the prst macro ple models the
ideal memristor properties. However, this window function can have problems when the memris-
tor is operated under some hard switching conditions. When the memristor is driven to its Ron or
Roff values, the Joglekar window function can lock in on that state with no means to drive it back to
normal operation. The Biolek window function includes some nonideal factors and suppresses the
memory effect on the boundary states to more accurately model the probable real life operation of
the device.

In order to compare the boundary effects of the two window functions, each type of memristor is
driven by an identical 1.6mA current pulse source. The transient analysis results of this simulation is
displayed in Figure 4.

The waveforms in the top plot show the voltage and current waveforms for the memristor macro

that uses the Joglekar window function. Once the driving current becomes large enough to switch
the memristor into one of its boundary states, the memristor locks into that state and no external

stimulus can change the memristor back to another resistance value.



The waveforms in the middle plot show the voltage and current waveforms for the memristor
macro that uses the Biolek window function. Even though the memristor is being driven with the
same current, it is not being locked into either boundary state which is the expected operation of an
actual memristor.

The waveforms in the bottom plot shows the ratio of the actual width of the doped area to the
width of the entire memristor thin plm for both memristor macros. The V(XJ.X) waveform plots
the ratio for the memristor using the Joglekar window function, and the V(XB.X) waveform plots
the ratio for the memristor using the Biolek window function. For the Joglekar plot, the waveform
locks into the 0 state after the prst current pulse and no longer reacts to any of the following current
pulses.
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Fig. 4 - Joglekar versus Biolek window functions

The Memristor_J macro provides a macro that will simulate according to the ideal memristor theory
whereas the Memristor_B macro tries to incorporate a little more of the real world effects that a
memristor may have.

Reference:

[1] BIOLEK, Z., BIOLEK, D., BIOLKOVA, V. "SPICE model of memristor with nonlinear dop-
ant drift." Radioengineering, 2009, vol. 18, no. 1.
http://www.radioeng.cz/fulltexts/2009/09 02 210 214.pdf



Using the Tolerance Dialog Box

Setting tolerances is typically done in the Attribute dialog box or by directly editing the model in the
schematic ple. If many tolerances need to be depned, this can become a tedious process. Micro-
Cap provides the Tolerance dialog box as a means to quickly add, edit, or remove tolerances for any
of the applicable components in the schematic. The dialog box appears as below.
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Fig. 5 - Tolerance dialog box

The Tolerance dialog box, which is accessible from the Monte Carlo dialog box and also from the
Change submenu under the Edit menu, lets you apply tolerances to multiple parameters at once.
You can apply LOT and DEV tolerances to any part that has a model statement. You can also save
Tolerance sets for later use on other models of the same type. The dialog box has these pelds:

Types: This list the parts types found in the circuit. You can select one or more types for toleranc-
ing, although only one type is usually selected.

Models: This lists each model found for the selected part type(s). You can select one or more
models for tolerancing. For resistors, capacitors, and inductors, if the Model attribute has not been
speciped in the schematic, the part will still appear in this list but be preceded by a <Blank> desig-
nator. If selected for tolerancing, Micro-Cap will prompt for a model name to assign the selected
part(s) along with the subset of parts from that entry to apply the model to.

Parameters: This lists the model parameters for each selected model. Select the parameters that
are to be toleranced. Use the Ctrl or Shift keys to select multiple parameters.

Lot: This controls the options for the Lot tolerance.

Add/Change: This adds or changes the Lot tolerance of the selected parameter(s) to the value in
the Tolerance peld, when the Apply button is clicked.

Leave: This option leaves the Lot tolerances unchanged.



Remove: This option removes the Lot tolerance of the selected parameter(s).

Lot#: This peld lets you enter a lot # for the Lot tolerance to provide a means for lot deviations
to track one another.

Distribution: This lets you select the type of distribution. Default means that the model will use
the distribution setting from the Monte Carlo Options dialog box.

Tolerance: This peld lets you enter the tolerance. You can enter an absolute tolerance or a per-
centage tolerance. For a percentage tolerance, you must specify the % symbol.

Dev: This controls the options for the Dev tolerance. The options are the same as for the Lot toler-
ance above.

Tolerance Sets: This lets you assign a name to a tolerance set so it can be used for other parts of
the same model statement type. To name a set, click on Save and enter a name, such as 60n_MOS-
FET or Caps_5%. This will save the tolerance settings on the current parameter list so any toler-
ances must prst be applied to the parameters before saving. To apply a tolerance set to the selected
parameters, select the set name from the list and click on Apply. To delete a tolerance set, select the
name of the set to be removed, then click on the Delete button.

As an example of how the Tolerance dialog box works, the circuit Diffamp.cir will be used. This
circuit is distributed with Micro-Cap. The Tolerance dialog box is invoked through the use of the
CTRL+SHIFT+T hotkey command. The three types of components that have models to toler-
ance in the Diffamp.cir ple are shown in the Types peld: NPN, PULSE, and RESISTOR. First, a
10% LOT tolerance will be applied to the BF, CJC, and CJE parameters of the N2 NPN model.
The NPN item is selected in the Types peld. Once selected, all of the available NPN models in the
circuit are then displayed in the Models peld. The N2 model is speciped in the Models peld as:

N2 (Q2, Q6)

which means that the N2 model is being used by the transistors with the part names Q2 and Q6 in
the schematic. Selecting the N2 line in the Models peld will then display all of the applicable model
parameters in the Parameters peld. Holding the CTRL key down, the BF, CJC, and CJE param-
eters are all clicked on in the Parameters peld in order to select them. In the Lot section, the Add/
Change option is selected. A value of 10% is entered into the Tolerance peld. Since only a Lot
tolerance is going to be added to these parameters, in the Dev section, the Leave option is selected
so that no changes occur to any Dev tolerances. The Tolerance dialog box should now appear as it
does in Figure 6. Clicking Apply will change the model in the schematic ple and update the corre-
sponding parameters in the Parameters peld.

For the next step, all of the resistors in the schematic will have a 5% Lot tolerance added to them.
In the Tolerance dialog box, the RESISTOR item is selected in the Types peld. In the Models peld,
the following line appears:

<blank> (R1,R4,R2,R5,R6,R3,R7,R10,R9,R8)

In the Diffamp.cir ple, there are ten resistors, and none of them have a model assigned to them.
However, in order to tolerance a resistor, a model must be assigned to the component. The
<blank> designation allows resistors without models to be selected in this dialog box. Once the
above line is selected, the applicable resistor model parameters are displayed in the Parameters peld.
In order to tolerance a resistance, the R model parameter should have the Lot tolerance applied to it
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